4VATARS PROJECT

Standard avatar specification for content creation in RealXtend

In partnership with the development team under opensource realXtend, the research program ENER
of Ecole Nationale des Arts Décoratifs de Paris, was introduced to study and specify the format of future
standard avatar of realXtend.

The purpose of this research conducted by Boris Ramonguilhem (student researcher) under the leadership of
Frangois Garnier (Head of research) was to specify bone structure of the skeleton of future avatar of realXtend,
to provide maximum compatibility with the different existing open source tools :

-Open source 3D file format

- mesh generator

- motion capture tools

- 3D content creation suite

This article presents the results of this research :

- the annotated description of the format of the new standard avatars for realXtend

- the description of the workflow to produce avatars : makehuman > blender > realXtend
- Animation sets : motion capture > blender > realXtend



4VATARS PROJECT : Jack, the current realXend ava-
tar

The default avatar of realXtend is named Jack. It is an only shirt & pants dressed caracter, with no hairs. By a
standalone application named Avatar Generator, users have possibility to customize the Jack avatar, by chang-
ing its body’s texture, head’s texture, the height...

This current application is very powerful because it gives to users a simple access to avatar customization.
However, Jack structure is quite closed because it is based on commercial and expensive application : Autodesk
3DSmax.

It is crucial for an Open Source project that the embedded media are also fully Open Source.

That’s why we decided to look for other solutions in the Open Source community. The nearest application is
Make Human (http://www.makehuman.org/). As it is said in their website : “MakeHuman(TM) is an open
source (so its completely free), innovative and professional software for the modelling of 3-Dimensional humanoid
characters. Features that make this software unique include a new, highly intuitive GUI and a high quality mesh,
optimized to work in subdivision surface mode (for example, Zbrush). Using MakeHuman, a photorealistic char-
acter can be modeled in less than 2 minutes; MakeHuman is released under an Open Source Licence (GPL3.0) ,
and is available for Windows, Mac OS X and Linux.”

What a good start!



4VATARS PROJECT : The current XML files

The XML description file

Whats for ?
realXtend ModreX was a kind of “plugin” to Opensim. Even if the 3D graphics are handled by Ogre3D engine,
the avatar had to keep some kind of compatibilities with the OpenSim (Second Life) avatars.

In detail

The XML description file is the bridge between the Ogre avatar and the Opensim avatars. Each lines describes
which ogre animations stored into the avatar.skeleton file, are bound to the standard OpenSim animations.

For instance :

OpenSim animation name for walking is “WALK?, it is stored into each opensim server as a specific UUID
“6ed24bd8-91aa-4b12-ccc7-c97c857ab4e0”. The XML code links the OpenSim “WALK?” to the ogre animation
name “Walk” In addition, with this xml file, user can customize some options like the playback speed of the
animation.

i H<avatar>
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The XML attachment file
What’s for ?
In the Avatar Generator application, users can add T-shirts, pants, haircuts to their avatar. The XML Attach-

ment file is the links between the additional accessories and the avatar body. It describes to with avatar model
the accessories could be attached, also to which part of the body.

1 <?xml version="1.0" encoding="utf=-8" =standalone="yes" 2>
2 <!-- Attachment data -->

3 <attachment>

4 <mesh name="Male_rock_grey.mesh" linkskeleton="0" />
5 <category name="Hair">

6 <bone name="BipOl_Head" />

7 </category>

8 <avatar name="Jack.mesh">

El <bone name="Bip0l_Head" offset="0.105586 -0.0266487 0.000374197" rotation="0.5 -0.5 -0.5 -0.5" scale="0.83 0.83 0.83" />
10 </avatar>»

11 </attachment>

12



4VATARS PROJECT : Redefine a standard skeleton
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Make Human is a famous opensource application, dedicated to the creation of 3D characters. Until the latest
versions, it aims to generate high quality photorealistic characters.

We took decision to use the Make Human skeleton as standard skeleton for realXtend.

The current realXtend avatar’s skeleton is based on Biped, a character animation module for Autodesk 3DS
Max.

The Make Human’s skeleton is really different. Bones names are different, also the skeleton structure of the
head. The Make Human’s head structure is already setup for facial animation and eyes movements.



Different part of the Make Human skeleton

The head bones : neck, head, jaw, tongue, eyes, lids The left leg bones

The back bones The left arm bones

The left hand bones



4VATARS PROJECT : Definition of the Workflow,
Make Human, Atopos, Collada open 3D format, Blend-
er, Ogre 3D, realXtend
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Once the skeleton was specified, a french motion capture studio called Atopos created animations, according
to the animation list of the XML description file.

Atopos studio provided two kinds of 3D formats containing bones structure and animations : BVH and Col-
lada. The Collada format is very central part of the project because it is open 3D format that you can use for
many applications, for instance 3ds max, Maya, Blender, Google Sketchup.

In this avatar project, the workflow was decided as following :

- Use Make Human in order to specify a generic structure of humanoid skeleton

- Atopos studio adapt a set of motion capture animations, to the make human skeleton
- Atopos provides collada 3D format with all animations

- Use Make Human to create the shape of the avatars

- Use Blender to link the animations to the skeleton and to the shape

- Use Blender to export the animated avatars to Ogre format

- Use Rexmeshtool.exe to fixe the scale and global rotation of the avatar

- Write the XML description file of each avatar



4VATARS PROJECT : ATOPOS, full sets of motion
capture animations

Walk Run

Stand Stand_1

Stand_2 Stand_3






Stand to sit




4VATARS PROJECT : MakeHuman, create the model
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Make Human has an interface with several layers of complexity. First the “General” layer where you can setup
basic body features such as the gender, the age, the height...

After, the “Details” layer is the part where you can change each little details, from the whole shape to the
smallest part of the face. Moving the shapes sliders, give you the possibility the switch the shapes presets.
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The “Modifiers” panel give possibility to modify the body parts, in symmetric or non-symmetric ways, by
scaling and moving operations. This simple tool gives the best opportunity to personalize the head shape.
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How to export your model ?

When the shape of the body is modelled, it is time to export it. The export options permit to save the skeleton
and the shape to several 3D formats, such as .bvh for the skeleton, .obj for the shape, .dae (collada) for both
shape and skeleton. The .mhx format is really interesting because it stores the shape, the skeleton and morph
targets. Via a plugin, this format permit to edit the body shape directly in Blender.

% = = ) Modeling v Libraries v| [Advanced | |E: e r v S Js Hell

Modeling v Libraries v [Advanced | [Experim.s% [R """ SR S SR R .
Save Load

Save Export options

Body

X | .dae | .md5 ||.md5

Export options

Body

mhx dae

Global cam

Face cam




4VATARS PROJECT : Import the Make Human model
in Blender

Note about the weight of your models

It is really important that your model is optimized for realtime 3D. It is a necessity if you want to connect to
immersing environments like realXtend. Because every objects in 3D has to be downloaded by each users.
Consequently, like in the web environment, all 3D objects and their texture have to be optimized.

The specific case of Make Human, about the weight of the models

In the origin, Make Human is not specially oriented for realtime 3D. But in the newest versions, the exported
objects are stored in 2 files. The first file stores an shape that counts 15340 polygons (30680 triangles in
realtime 3D). That is too much for realtime web application. The second file with “_ascottk” suffix counts 1784
polygons, almost ten times less than the high definition model. This is very good for web applications. That’s
the file we will use as avatar for realXtend.

Make Human exports the models in a specific path. For instance in Windows, path is :

C:\User\Documents\makehuman\exports

L Mr Spock.obj L mr spock_ascottk.ob)
Fichier OBJ Fichier OBJ
2,24 Mo 174 Ko



Make Human to Blender

For now, the ogre exporter is only compatible for Blender 2.49. Also you have to install Python 2.6 (free).
Blender 2.49 collada importer is buggy, consequently from Make Human I'd advise to export in OBJ format.

In Blender, File > Import > Wavefront (.obj)
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When the import process is finished, you should see the model in center of the viewport. Right-click on the
mesh to select it.

Cleaning some unecessary polygons in Blender

Inside the body mesh, there’s some unneeded polygons that should be deleted to optimize the mesh.
Switch to Edit Mode by click this button or by pressing TAB key.
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1. When the extra polygons are
selected, delete them by pressing
X key, or

Mesh > Delete...

2. A second dialogue box appears
: Choose Vertices.

This operation delete the complex inside part of the mouth and some very unneeded free vertices. The poly-
gon count falls to 1 714, that’s pretty good!

Adapt the mesh to the Mocap skeletons

The skeletons centre of Make Human are in the middle of 3D space. Consequently the lower part of the body
is under the 0, that means in virtual world under the ground.
To avoid that little problem, we shifted the position of the Make Human skeleton so that the feet of the avatar

are on the ground.

The mesh of the Make Human body also need to be aligned to the skeleton.
1. Switch to Edit Mode

2. Select all the vertices, by pressing A or
Select > All

3. Move the whole mesh follow the Z axis to align the height

4. Align the mesh along the Y axis




Creating the texture for the model, in Blender

The texture coordinates of all the Make Human are like this one below.

The eyebrows are separated of the forehead.

The texture coordinates of the torso and the
lower part of the model are quite distorted.
Consequently, that’s not easy to create the
texture in a traditional way, with a simple pho-
to editor.

In Make Human model case, I would advise to use Paint 3D and texture projection techniques that exist in
Blender but also in Photoshop.

In Blender you can switch to Texture Paint mode. In this mode you will be able to paint directly on the 3D
model. This process will project your painting operations directly on the texture picture.




4VATARS PROJECT : Shape and textures workflow for
the realXtend basic avatars

For the benefit of the realXtend project, it had been decided to create 4 characters, a man, a woman, a boy

and a girl. The four characters were created with Make Human. Due to the different characteristics of their

ages and genders, Atopos Studio had to create 4 sets of motion capture animations, that feat to each body’s
proportions and fatness.

Skeletons height :
Man: 185 cm
Woman : 170 cm
Girl : 160 cm
Boy:175cm

Textured caracters in Blender viewport

The man




The woman

For this character, 2 additional objects were created : the skirt and the hairs.



The girl

For this character, the hairs were added.



The boy

For this character, the baseball cap with realXtend logo was added.



T I “_.1.1.__ q...i !

It __....._._ _-

A

L

8 _”_w.....J- .- —_ |

i

in Naal

imated characters

mma

Textured and an




